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lab reports for all labs (list labys)

Lab 3-1 Install Visio

Lab 3-2 Set up star network and have checked off

Lab 3-3 Installing Active Directory on ADDC-1 and ADDC-2

Lab 3-4 Installing Server 2012 and Joining the Domain

Lab 3-5 Installing another domain controller in its own forest

Lab 3-6 Joining your Workstation to the Domain

Lab 3-7 Using Network Monitor on Server 2008

Notes completed

Completed solution to problem portfolio

Explanation of the option of different kinds of topologies, including bus, star,

cascading star, token ring, and mesh.

Explanation of the options of different types of architectures, including Ethernet,
token-ring, ARCNet, and FDDI)

Access methods used by each topology.

Suggestion of which topology would best fit their needs.

Explanation of the option of different kinds of topologies, including bus, star,

cascading star, token ring, and mesh.
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Explanation of the options of different types of architectures, including Ethernet,
token-ring, ARCNet, and FDDI)

Drawing of the network, which includes:

All computers on network (servers and workstations)

Label cable types

Label connector types

Label access speeds

Label access method

Describe topology and architecture
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Notes!

Kinds of topologies
| —Describes the actual layout of the network transmission media.
| —Describes the path the signal follows as it travels along a network.*

Physical vs logical topologies

BUS Topology

m Uses
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| is the most common BUS topology

m Most bus networks broadcast signals in directions on a cable.
| must be placed at each end of the backbone cable to prevent signal bounce.
| must be done at one end.*

BUS Topology
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BUS Topology-No Termination

Improper termination
can cause signal bounce
on an Ethernet LAN!

Ring Topology
m Network is wired in a ora
m Each device has a and a

m Each device serves as a

m Signal is very low
m Physical rings are very rare. Rings are usually in nature.*
© Tory Klementsen -5 3/18/2013
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Ring Topology

m Ideal for passing access methods.

m Often has schemes built in.*

Ring Topology

=

———————\

Token Ring

m Token rings use a architecture
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m Adhere to the standard.

] star, ring

m Each node is attached to an (multi station access unit)

m The adds fault tolerance so if one computer goes down, the network still works.*

m Token ring cards run at either Mbps or Mbps

m All must run at the same speed

m Each node acts as a .Itreads a and sends it on to its nearest neighbor.*
m If a node has a , it captures token when it comes to it.

m It then sends the

m The receiving node receives the message and replies with a " message.

m The sending computer receives the got it and then releases the token back onto the

.*Token Benefits
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.Equal to all computers

B Able to use priority
.Very networks—keeps from down
B \When carrying time data that is imperative it be received

Auto-reconfiguration

B Computers on a token network receive transmissions every seconds.
B If a computer , it is removed from the network. When it comes back, it
won't packets.

Bif 7 seconds pass and it hasn’t received a packet it sends out a *

packet with its address and the address of its nearest neighbor

BBy doing this, the can determine where the problem is and

automatically reconfigure the network to include that computer.”
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Review

m What is the logical and physical topologies of token ring?

m NIC card speeds?

m All nodes are connected to a...

m What is a beacon?

m If a computer doesn’t answer a beacon, what happens?

m Describe how a computer sends data on a token ring network.

m What is the purpose of the token?

m When a computer receives data meant for it, what happens?

m How many computers on the network will see a data frame?
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Star Topology

m All devices connect to a

m The hub receives signals from other devices.
m Can be used to implement a or logical topology
© Tory Klementsen -10 - 3/18/2013
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Star Topology

Star Wired Bus

m Hybrid topology that combines and

m Groups of workstations are connected to (star)
m Hubs are connected by single (bus)

m AKA Star Bus
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Ethernet Standards (802.3)

m Speed—Originally Mbps, but 802.3u is Mbps, and 802.3z is
Gbps

| —Bus or star physical, always bus logical

| —coaxial, twisted pair, and now fiber

u

© Tory Klementsen “12- 3/18/2013

Z:\0-Skills Center\Modules\Networking\Mod 03 Topologies and Architectures\2013\Network+ Mod 03 Topologies and Architectures.docx



Mesh Topology

m Each device is attached to each other in the network.

m Considereda “ ”topology because it can incorporate all other topologies.
m !

m Difficult to use in a large LAN

m Completely tolerant

m Can be all or ring and ethernet
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Mesh Topology

Review

m What are the three major network topologies?

m What is the difference between a logical topology and a physical topology?

m In a star topology, what is every device connected to?

m What must be done at the ends of an ethernet BUS?
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m Which topology is also referred to as a “hybrid” topology?

m Which is rare, a ring physical or a ring logical topology?

m Where are physical ring topologies often used?

m A star topology can be a physical star, but a logical _ or __ topology.

m Which topology is the most fault tolerant?

m Which topology is the most expensive?

m Which topology is the least expensive?

m Which topology often uses a token passing contention method?

m Which contention method listens before it transmits a signal?
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Backbone Networks

m A network backbone is the cabling that connects )

m Backbones usually have greater than connected cabling

m Backbones carry more

m In a large enterprise network, is often used as a backbone

Serial Backbone

n backbone

m Two or more networking devices connected via a single cable in a

m Limited because it can quickly become *
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Distributed backbone

m A number of connectivity devices connected to a series of central connectivity devices

m Easy to as the company/network grows.
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Collapsed Backbone

m Uses a or as a single central connection point for multiple subnets

m Easier to manage and

m Cheaper than ..but

m When multiple LANs are connected to one router, you have a risky situation

m One of can bring down an entire network
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Collapsed Backbones
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Parallel Backbone
m Most
m Combines and
m One or more connections from the central to each network

®m Redundant links ensure network connectivity

m More expensive due to increased

m Better tolerance
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Parallel Backbone

What is a Standard?

m Topologies simply describe layouts, but don’t get into wiring, etc.

m Standards define
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m Example: Ring is a topology, token ring network is an architecture or standard

m Standards are in the 802 groups.

Review

m Which backbone is the cheapest?

m Which would be most expensive?

m Which would provide the best security?

m Which include a single ingress and egress to the rest of the world?

m Which include fault tolerance?

ArcNet

m An network not often found in business.
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m Uses token protocol.

m Can have a or physical topology.
m Uses or hubs, not an MSAU.

m Requires a ohm terminator.*

FDDI

m Similar to token ring
m Uses optic cable.

m Two classes of FDDI

— Class A—uses rings that run in

—Class B—uses a ring.*

Wireless LAN (802.11b)

m Speed—
m 802.11b Mbps
m802.11g and
m802.11n to mbps
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m 802.11ac mbs to Gbps

m Media—2.4Ghz and radio waves

m Topology— wireless, bus (because it is based on Ethernet and E’'net always

uses logical bus)

m Access Method— / *

FDDI

m Speed— or higher

m Topology— ring for fault tolerance

m Media—Fiber optic, although you can use (then called ) with the same
technology

m Access Method— passing
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Lab 3-1 Installing Visio and running tutorials

Check off
Installed Visio
Installed new shapes
Drew sample network (our room)
Labeled the room cables, etc.
Input an annotation box
1. Get out your Visio disk.
2. Start your computer and log into an administrator account.
3. Insert the Visio CD and run the installation.
4. Complete the tutorials at: http://office.microsoft.com/en-us/visio/HA010837201033.aspx
Do Dis:
1. Open Visio [ Mechanical Enginesting

2. Notice that there are a lot of options for drawings you can create. We want to draw a network, so

MNetwork
select Network [ e w'_“ -
[ ©rganization Chark

[l Process Endineering

3. Select Detailed Network Diagram using US Units

4. Visio will open a blank page. The difference in templates is the shapes that open with it. Look on
the left. You'll see bunches of shapes that can be used for your network.

5. Let’s create a simple star topology network.

Detailed Mebwork Diagran
{5 uniks)

Click on Network and Peripherals and find the switch. It's just a generic switch.

Click and drag it onto your drawing space.

If you're creating a specific drawing using specific switches, you can download shapes from e

companies like Cisco.

9. If you're doing a general drawing, such as a proposal, there are accepted symbols that you would
use.

10. Click on Network Symbols

11. Find the workgroup switch. Drag it over to your drawing board. Notice that it has arrows that

represent data sending and receiving.

© N
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12.

Go back to peripherals and drag over one server and one computer and one router. Go ahead
and click on the switch symbol, hit the delete key and delete it. We’'ll use symbols later.

13.

To make it easy you can copy shapes. Hold down the ctrl key on your keyboard and click and
drag the computer you brought over. Create three of them.

14.

15.

Now lets label each thing. Click the switch and just start typing 32 port switch. Label the others
as shown.

Let’s create another Active Directory Server. Click, hold down control, and drag. Rename it
ADDC2 by double clicking on the words and typing.

32 port switch

>

router

16.
17.
18.

19.

20.

e

¥
32 port switch w
addc2

Now lets connect them together. Go up to the toolbar and select the Connector Tool.
Notice that as you bring your mouse over the switch it highlights where you can connect.
Click on the switch and drag the connector line to ws1l. When ws1 gets a red box around it, let

go.
Now pick up and move ws1. What happens?

Connect the rest of the devices.

3

ws1

addc1

router

ﬂv Tl A - G| 104%
—m Conneckor Toal m
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Click and
drag from
switch to|ws1

32 port switch

21.
22.
23.

24,
25.

Go into Annotations in the shapes. Drag over the one named 5 ruled column for annotation.
Click and type in your name, team name, and any other important information.

In EVERY network drawing you will annotate. This is a good place to indicate things like how
many workstations one computer represents, speed of network, type of cable, etc.

Now go over to annotations and grab “Callout Bent”. Connect it to your router.

Type BootP Router. (That means the router will pass broadcast messages for DHCP and for
network booting.)

Tory Klementsean

Team Tory

| Rock. Yes | do.

26.

27.

28.

Save your drawing. It will save as a VSD file (a visio desktop file). That’'s good for opening it and
modifying it later, but if you want to put it into another program you need to export it.

Now let’s save it as a JPG. Note that once you do this, you won'’t be able to change the JPG and
any changes you make to the VSD won’t go to the JPG.

Go to file>save as... and select Jpeg. Ta da!

lab 3-1 drawing.vsd

2! |Drawing (*,wsd)

SR

Partable Metwork Graphics (*.png) |}

Tag Image File Format (* kif)

windows Bitmap (*.brop; *.dib) -
——{indows Metafile (*.wmf) halS

29.
30.

Now create a new document and do the following
Go under File>Shapes—>Network and note that there are a LOT more network shapes. Select a

Each person turn it in!
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31. Go to www.visiocafe.com and download the following shape packets:

32. Now using the Network shapes and the Building Plan shapes, draw this room!

few and poke around.

a. Dellfull.zip
b. Microsoft Network Equipment Shapes

Lab 3-2 The Star Topology

In this lab you’re going to set up a simple star physical network using three or four computers in your group.

Check off

Set up a small network

Can ping each other computer

Answered questions
Put materials away and reconnected
all computers.

Get the following:

“B  Two or three computers running Windows

“B  Enable file and print sharing on both computers
“B A small network hub

“B Cabling for each computer

1. Log off and turn off the computers.

2. Obtain a hub or switch. Connect each network computer to a hub. You are not going to connect this hub
to one of our routers. We want just a simple peer to peer network.

3. Turn the computers back on and log in locally.

4, Change the computers from working within a domain into a workgroup. Each computer must have a
unigue computer name, but the workgroup names should all be netplus.

5. View your network and see if you can see the other person. Open your command prompt, get the IP
address from the other person. Type ping <ip address> So if his IP is 192.168.1.234 you’d type ping
192.168.1.234

6. What do you see?
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7. Unplug one of the computers. What happens to the light on the NIC?

8. What happens to the light on the hub?
9. What do those lights indicate?

10. View network again.. What do you see?

11.  Why?

12. Reconnect your workstations to the classroom network. Restart both computers.

13.  Rejoin the domain as before. Restart the computers. If you do this on your servers do NOT rejoin to the
domain!
14.  Draw a picture of your tiny network to the right.

Lab 3-3 Installing Active Directory

Check off
Setup ADDC1
Added AD Role
Created a new domain in a new
forest
© Tory Klementsen -30- 3/18/2013
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Joined ADDC2 to domain

Installed AD Role on ADDC2
Show both DCs in ADDC1

Answer Questions

Before you start:

1.

2.
3.
4

5.

If you don’t have your Server 2008 DVD, be sure to have the ISO available.
- Network ~ 192.168.1.71 » ISOs + v £ |searct

=2 views New m
Name |

ol en_windows_7_enterprise_n_x86_dvd_x16-11935 {
# en_windows_automated_installation_kit_for_windov#e7_and_windows_server,

o en_windows_server_2008_r2_standard_enterprise_datacenter_web_x64_dv..

272

1) chrome-0s-0.4,22.8-gdgt.vmdk

Check youfcomputer name on both of your ADDC servers. If they are some funky nhame, change them so it's something easy to spell. NO LEET SPEAK.

You’re going to install Active Directory on your server. That will turn the server into a Domain Controller, or an Active Directory Domain Controller (which is
why we named the virtual servers ADDC1 and ADDC?2).

Read on about Active Directory so you know what you’re doing.

Active directory is a directory that contains information about all of the objects in your network. Objects can be users, computers, shared folders, shared printers,
organizational units*, etc. It also contains information about programs, what services are available and where to find them, security access, permissions, etc. In
other words, it knows EVERYTHING about the stuff in your domain and controls access to those things.

AD is REALLY powerful. We’re going to do the main Active Directory stuff in this class, but we’ll only scratch the surface. You can do some super cool stuff with

AD!

The basic building blocks of Active Directory are Domains, Domain Controllers, Trusts, Users, Groups, Forests, Organizational Units, Sites, Replication, and the
Global Catalog.
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A: Domain

Domain Forest
{Domain trees joined by trust relationships)

=organizational Un it (OU) v

Domain Tree

Here we have two forests. A forest is a collection of domains. A domain is a collection of users, organizational units, computers, servers, shares, etc.

We’ll learn more as we go along.

Directions
1. Log into your server as an administrator. 1. What is the minimum number of Domain Controllers you
2. Hyper V Manager. should have in one network?
3. Start your ADDC1 server and log it in. Check the computer name. If it is 2. Why?
a funky name, rename it a single, easy to spell word. We'll be using UNC
pathnames so you don’t want to have to type \win-22390ea24 when it 3. AD DS will require to be installed.

would be a lot easier to remember \snappy and \\slappy (that’s what |
named mine). Restart after naming.

4. What do you do if you don’t have that?

4. Under Customize this Server select Add Roles
5. Select Active Directory Domain Services 5. After you install the role, what do you have to do to make
6. It will tell you that you have to add the .NET framework, so say Add the server a fully functional domain controller?
Required Features.
7. Read the Introduction to Active Directory Domain Services and answer the
guestions to the right. 6. What are three other things AD will install?
8. BEFORE YOU CONTINUE, MAKE SURE YOU ARE NOT DOING THIS
ON YOUR ORIGINAL SERVER. IT SHOULD BE ON ADDCL1.
9. Selectinstall. It can take awhile to install. If you didn’t answer the
guestions to the right, you can look up the answers online.
10. Click close when it’s finished. Make sure it says “successful” under both
items you installed.
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file://win-22390ea24
file://snappy
file://slappy

11.

12.
13.

14.

Open Server Manager to ensure that your new role was installed correctly.
Ruh Roh! Nothing is going on yet! Why is that? Well you need to actually
PROMOTE your server to a Directory Controller. So how do you do that?
Right click on the CMD program and select run as an administrator.
Type the word dcpromo (domain controller promoter) at the command
prompt. ONLY an administrator can installed the ADDS so you have to run
as an admin.

Since you’re a new user, just click next. Do not go into Advanced Mode.

C:\Users\Admin iscrato

@/ Active Directory Domain Services Installation

Welcome to the Active Directory
Domain Services Installation
Wizard

This wizard helps you install Active Directory Domain
Services (AD DS) on this server, making the server an
Active Directory domain controller. To continue, click Next

Ix

15.

16.

17.

18.

19.

You're going to get some information about OS compatibility. Read it if you
like. Press Next.

It's going to ask you whether you want a new or existing forest. A forest is
a collection of domains. Since this is your first domain and your first
domain controller, you are going to select create a new domain in a new
forest.

A domain is a collection of computers that share the same namespace
(example Microsoft.com, Redmond.microsoft.com,
Bellevue.microsoft.com).

Click next. FQDN=Fully Qualified Domain Name. You're going to create
a root domain name. csn.com is OUR domain name, so you can come up
with something good...but let’'s not be childish. And NO LEETSPEAK!
Srsly. You'll be in big bad trouble. Go ahead and use .com. (Example,
slaphappy.com.) The root is the first domain in your forest.

Hit next.

" Bxisting forest
« Sdd & domain G

1 EXIsting dormarn

forest

i cantroller.in the new domain

¢ Create a new domain in a new forest

Name the Forest Root Domain

The first domain in the forest is the forest root domain. lts name is also the name of
the forest.

Type the fully qualified domain name (FQDN) of the new forest root domain.

FQDN of the forest root domain:

Islaphappy.com

Example: comp.contoso.com

20.

21.

I's going to ask you if you’re all 2008 or have older servers. We may put a
2003 server into our domain, so leave the Forest Functional Level at 2003.
What this means if is you have even ONE older server acting as a domain
controller in your network, you have to have the FFL down to its level. At
native level (2008) it has more options and features.

You’re going to do the same with domain functional level. Same deal, but
at a domain level.
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22

23.

24,

25.

Il now exam your DNS. You don’t have a DNS so it will tell you that and
give you the option of either installing DNS or accessing another
computer’'s DNS. For this server, we will install a DNS. So just allow it to
install DNS (where it says additional options for domain controller).

Notice that Global catalog is also going to install. The reason is, your root
domain always holds the global catalog.

The global catalog is like a catalog that has every single item indexed in it
that is a part of the entire forest. It's like Dex, but cooler and not bald.
Ruh Roh, there is no delegation for our DNS server! That's because this is
our first one. When you have a delegation, that means that you have
another DNS that has all the files for all of the computers in the domain.
Go ahead and say yes to continue because this will become the Zone
Authority.

Select additional options for this domain controller.

[V DNS server*—-ﬂ

¥ Globalcatalo

d

[ Read-or

Additional i
The first do
cannot be

We recomm|
controller.

Examining DNS configuration...

Bin

h|

26.
27.
28.
29.
30.

31.
32.

The next screen will ask where you want to store your log files and your
SYSVOL folders. Go ahead and it store in C:\

Create a STRONG PASSWORD! We’'ll use P@ssword.

Review your summary. Does everything look correct? If so, click install.
Note that it will “talk” about what it is doing. This can take awhile, and you
can’t turn off your computer while it's doing it.

Nor can you install ADDC on your other domain controller because it's
going to be a backup domain controller. Sorry.

Click “Reboot on completion” and answer the questions below.

Note, when it reboots it takes a LONG time to restart to the point where
you can log in. This only happens the first time as it sets up all the new
services so don’t panic.

For better peformance and recoverability, store the database and log files on separate

volumes.

Log files folder:

IC:"-.‘-'Vindo'A's\.NTDS
SYSVOL folder:

Database folder:
AWindows\NTDS / T

e Browse

IC:"-\‘.’Vindows"n.SYSVOL

oy Browse...

44

33.

Once you have completed ADDC1 start up both ADDC1 and ADDC2. Log
both in.

34.

Make sure ADDC2 has an easy name. If not, rename it.

35.

Open the RUN command in ADDC2 and type DCPROMO. This is the
command line prompt for starting Active Directory Installer/Promoter.

36.
37.

38.

39.

40.
41.

This time you are going to select Existing Forest.

Type in the name of your domain (the one you set up on ADDCL1. Mine is
slaphappy.com).

Type in the username and password for an administrator on ADDC1 (so it
will let you join the domain.

If it doesn’t work the first time, try taking the .COM off the end of the
domain name.

The rest is the same... install and restart.

To ensure it is in there, go to ADDC1 and open up Administrative
Tools—>Active Directory Users and Computers.

(" Existing forest

€ 4dd a domait cortroller to an evisting domain

C Cre

P A
Rl

1 cantrollerin the new domain

¢ Create a new domain in a new forest
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42.
43.
44,
45,
46.

Click on Domain Controllers.

You should be both of your servers in there by name.
Mine are SLAPPY and SNAPPY.

Note that DC type is GC. That stands for Global Catalog.

Shut down ADDC2 so you only have ADDC1 on and open up your Server
2012.

File Action View Help

e | 2mo0le=HE|32:T72%

: Active Directory Users and Comput

# || Saved Queries
= 3 slaphappy.com
] Builtin

¥

# || Computers

Name | Type I DCTyr
15| APPY Computer GC
1A SNAPPY Computer GC

= | Domain Controllers 4"——.

,,‘; ForeignSecurityPrincipals
# || Managed Service Accounts
| Users
Questions
1. What is Active Directory?
2. What things are the building blocks of Active Directory?
3. What server did you install AD on?
4. What is DCPromo?
5. Why put the forest functional level at server 2003?
© Tory Klementsen -35- 3/18/2013
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6. If you have one server that is 2003, and three that are 2008 and all are ADDCs (Active Directory Domain Controllers), what Domain Functional Level do
you set it at?

7. What is a forest?

8. Whatis a domain?

9. What is your root domain?

10. What did you name it?
11. What three roles are you installing on your server?

12. What is a global catalog?

© Tory Klementsen - 36 - 3/18/2013
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13. What domain holds the global catalog?

Lab 3-4 Changing your Server’s Name and joining domain

Check off

Install Server 2012

Renamed server to something easy

Joined server to domain

Answered questions

Create a new Virtual Machine

1. Using the steps you learned in the previous lab, create a new Virtual
Machine with the same specifications that you would use for Server 2008. Enter the product key to activate Windows

2. Name it Server2012 (the VM)

3. Locate the ISO for server 2012 (it will be in 1ISOs). Note: Server 2012 is ‘ ™
ONLY 64bit so if your host server 2008 isn’t 64 bit, you get to reinstall! It should be on the back of the L 1’Ihe‘second"and or &
Yay! Windows. third sets end in

4. Itinstalls almost the same as 2008, except you have to enter the product The product key looks like this: 3 / the letter B. i
key DURING installation. - &

5. Note that it is 47njb and ww3cb Dashes will be added automatically. /

6. | thought it was 8 and couldn’t figure out why it wouldn’t accept it! = macams

7. Don't be dumb. like me. K7TD3-47NJB-WwW3CB|-PY413-3PBT3 Ll{'fy‘

8. You have two options with this server. The top is Server Core which only
installs a command prompt and is completely command driven. : x

9. The second installs g GUIp. Choose tha’?one.y Operatmg Zysten z 2 SN

Windows Server 2012 Standard (Server Core Installation) x64
Windows Server 2012 Standard (Server with a GUI) x64

10. The rest will install just like Server 2008. Answer the questions while it's
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installing.

Installing Windows

Copying Windows files (0%)

Installing features
Installing updates
Finishing up

Change Your Server's Name

1. From your dashboard select local server
28 Dashboard
i Local Server
l& All Servers
2. Click on the computer name (mine is WIN-
1C562...blah blah blah). Computer name WIN-1C562GRG3ME
3. The dialog box will come up that tells you what the Waikaroun WORKGROUP
name is. =
4. In description type Server 2012
5. Click the change button to change its name. For example: "1IS Production Server” or
"Accounting Server".
WIN-1C562GRG3ME
WORKGROUP
Jter or change its domain or
6. | changed mine to Sparky. Name it something
simple. Mine are Slappy, Snappy, and Sparky.
7. Click Apply. Computer name:
8. Click okay. [sparky
9. Restart your server for the name change to take
effect Full computer name:
sparky
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10.
11.
12.
13.
14.

Restart, log in, go back to local server.

Click on computer name.

Click on change.

You’re going to change the domain this time.
Make sure your ADDC1 or 2 is on and double
check the domain name. Mine is on and the
domain name is slaphappy.com

Full Computer Name: slappy.slaphappy.com

Domain: slaphappy.com

Local Area Connection 3: Multiple IPv4 addresses, IPv6 enabled

15.

Type in the name of your domain on Server 2012
(A) and click OK (B)

More...

Member of

(® Domain: (A}
slaphappy.com| S I

() Workgroup:
WORKGROUP

OQB Cancel

16.

17.
18.

Type in the administrator username and password
for the OTHER server since you are joining this
server to the other domain.

Click OK.

If it does not join the first time and you are SURE
that you have the right username and password
AND that ADDC1 is on and accessible, try
removing the .com from the domain name.

Windows Security

Computer Name/Domain Changes

Enter the name and password of an account with permission to jein the
domain.

l administrator Thl-s !S e
administrator
for your
| eeseessd| OTHER server
ADDC1
Domain: slaphappy.com
| OK | ‘ Cancel |
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19. When it says welcome, restart and go onto the next
lab.

20. Your computer should now have a Fully Qualified
Domain Name because it’s joined to a domain. On
mine, it's name is SPARKY but its fully qualified
domain name includes the name of the domain so
it is SPARKY.SLAPHAPPY.COM Yay' '

Computer Name/Domain Changes

o Welcome to the slaphappy.com domain.

Activate Windows

1. Make your 2012 full screen. ~
2. Hit the Windows key on your keyboard. aSEurity =
3. Type act,. and click Settings. Activate Windowes now (important) _
4. Click Action Center. Windiws iesiallafion is incceplein. Go bo Windows (Go to Windows Activation
5. GO tO WIndOWS ACtlvatlon .l:lillt'll.ﬂ'l'.l.' aterale Windewi

. . s off ages aboud Windows sctrestian
6. Activate Windows now.
7' CIICk ACt|Va.te. Turn on Windows SmartScreen (Important)

‘Windows SmertSereen can help kbeep your PC safer by waming [l Change setbiregs |
2 s . - . y beefore runming wnr niced nd files dovsnloaded
% Windows isn't activated F",Z:'_“ﬂ_:,::ﬂ' P ey Appe mnd e Sownloe
“,. * Windows can't be activated right now. T Turm off miessages sbout Windowss SmatSoreen

Support online to activate Windows.

Current edition
Windows Server 2012 Standard

Current preduct key
*+++*.3PBT3

8. If it doesn’t work, then you probably didn’t put Have Tory check off
the proxy in, did you? Go on. Admit it...| won’t
make fun of you...much.

Turn off IE Enhanced Security

1. Getto the dashboard and click on local

server. —
BE Mochbeard
B Local Server
B Al Servers
g File and Storage Services b
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2. Find where it says Enhanced Security
Configuration and click OFF!

3. Sheesh | hate that thing. | turn it off on all Windows Error Reporting Off

servers. - - . . PR
4. NOW Open |E and see If it’S gone away. Customer Experience Improvement F’D-;I’EII“ Vot parcc :Iatlllg
5. Ifit still says “on” on the local server page E Enhanced Security Configuration - On

you can refresh it by clicking the little Time zen (UTC-08:00) Pacific

refresh button at the top. Otherwise it . ] T 1 1.'1.' - P
. . d  Product D 00184-20455-0040
refreshes automatically every ten minutes. reeke u rn It 0 l ’

Questions
1. What did you name your computer?

2. What is your computer’s Fully Qualified Domain Name?

3. Your neighbor is trying to do this lab but you notice he does not have his ADDC1 open (or ADDC2). Explain to him why you can’t join a domain if the DC is
not on. What will you tell him?

Lab 3-5 Installing Another Domain Controller

Check off
Installed Active Directory Services
Set up a new Forest
Answered guestions
Did not cry or tear your hair out over
installation of directory services
Before you start:

6. Make sure you have one of your domain controllers turned on. You can’t have both ADDC1 and ADDC2 and Server 2012 on at the same time.
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Directions

47.

48.

49.

50.

51.

52.
53.
54.

55.
56.

57.

Log into your 2012 server as an administrator. Be
sure ADDC1 is on and working and has Active
Directory installed.

Go into the properties of your network card and
configure IP v4

Set the Primary DNS as the IP address of
ADDC1.

Set the secondary DNS as 127.0.0.1 (that is the
“local” or “home” address that refers to the NIC
being used on that computer).

Write down that IP address here:

Under Customize this Server select Add Roles
Select Active Directory Domain Services

It will tell you that you have to add the .NET
framework again, so say Add Required
Features.

Select install.

When it's done, open the RUN box and type the
command to promote the server to a domain
controller.

Things have moved in Windows Server 2012! Go
to Server Manager.

=) Run

.
7

Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Open: | dcpromo[ v

' This task will be created with administrative privileges.

| oK || Cancel H Browse... |

L

The Active Directory Domain Services Installation Wizard is relocated in
Server Manager. For more information, see
http://go.microsoft.com/fwlink/7Linkld=220921

Active Directory Domain Services Installer

i

1. Goto Server Manager
2. Click :‘add roles and features”. If it tells you that 0 Co 'ﬂch ure this ’OCS server
it can’t start because it is completing a task, just
wait a bit and try again. /
2 Add roles and features
3. Skip past the first page. On page two you want to = - ]
select role-based or feature-based installation. ®' Role-based or feature-based installation
4. Notice when you click next that you can actually Configure a single server by adding roles, role services, and features.
create a role on a virtual drive, or another server.
Virtualization is more than just setting up servers
to learn from. Companies are using them now for Install required role services for Virtual Desktop Infrastructure (VDI) to create :
production. or session-based desktop deployment.
5. Next
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6. Select your server.
. Server Pool
7. Click next
Filter:
Name IP Address Operating System
WIN-1C562GRG3ME 192.168.1.211 Microsoft Windows Server 2012 Standard
8. Select Active Directory Domain Services. Roles
9. These services allow you to add users, groups,
organize users into groups, add computers, [[] Active Directory Certificate Services

organize users, groups and computers into

organizational units. s : :
10. Click next ctive Directory Federation Services

[ Active Directory Lightweight Directory Sen

Active Directory Domain Services

[] Active Directory Rights Management Servi

11. It's going to show you what features will be
installed as you add Active Directory.
12. Active directory is a directory service to control the

things | mentioned above. . : :
13. Be sure “Include management tools” is selected Add features that are required for Active Directory

and add features. Domain Services?

You cannot install Active Directory Domain Services unless the
following role services or features are also installed.

[Tools] Group Policy Management
4 Remote Server Administration Tools
4 Role Administration Tools
4 AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
4 AD DS Tools

[Tools] Active Directory Administrative Center
[Tools] AD DS Snap-Ins and Command-Line Tools

Include management tools (if applicable)

Add Faqtures Cancel
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14.

15.

Scroll through the list. Which features are going to
be installed?

Click next

Features

(MR NET Framework 3.5 Feature R ,

------- =+=lled
»Lglicu

[] Background Intelligent Transfer Service (BITS)
[[] BitLocker Drive Encryption

[] BitLocker Network Unlock

[] BranchCache

[] Client for NFS

[ ] Data Center Bridging

[[] Enhanced Storage

[] Failover Clustering

Group Policy Management

[] Ink and Handwriting Services

[] Internet Printing Client

[] IP Address Management (IPAM) Server

o AR v

< " ‘ >

16.

17.

18.

19.

20.

You will see a list of things that apply to your
domain services. Read and answer.

How many domain controllers should you have at
a minimum?

AD DS requires a
server to be installed.
Look up DFS, what is it?

What parts of DFS will be installed?

Go ahead and tell it to reétért your server when finished.
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21.

22.
23.

You can close the wizard (couldn’t in other
versions) and if you want to see how it's coming
along, click on the flag to see what's going on.
Mine is about 2/3 done in this picture.

Keep an eye on the flag. When it has a yellow
v'varning sign on it, click and you should see:

Post-deployment Configura...
NAGI
—= Configuration required for Active Directory D«
Services at WIN-1C562GRG3ME
) C' Promote this server to a domain controller

o Feature installation
—

— Installation succeeded on WIN-1C562GRG3M

> Add Roles and Features

o Feature installation
{AGI||

] ]
Installation started on WIN-1C562GRG3ME

C (| Add Roles and Features

Refresh

- Refreshing servers...

24,

25.
26.
27.
28.

29.

Restart your server and be sure to log into your
2012 server as your administrator in the domain
you created on ADDCL1. To be extra sure, you can
make an administrative account so it's easy to
know you’re in the right one.

Go into ADDC1

Open Active Directory Users and Computers.
Create a new user and make you a member of the
domain admins and Enterprise admins.

See over there, | created me and made sure | was
a member of Enterprise Admins.

Go over to server 2012 and log in to THAT
account.

; Enterprise Admins Properties Y

m  General Members | Member Of | Managed By |

Members:

Name | Active Directory Domain Services Folder
‘ Administrator slaphappy.com/Users
{., Tory Klements... slaphappy.com/Users

»al
ou

30.
31.
32.
33.

Click Promote this server to a domain controller.
First be sure your IP address is static.

Click promote this server to a domain controller.
When the program restarts you will see an AD list
in the server manager.

B Local Server

@ All Servers

! ADDS

W§ File and Storage Services P
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34. You need to finish the task of making this a
domain controller.

35. Click add a new domain to a new forest (a)

36. Name your new root domain. (B)

37. Click next

Note: It's normal for it to take a bit on each screen before
you can click.

Deployment Configuration

Deployment Configuration

Domain Centroller Cptions

Select the deployment operation

) (O Add a domain controller to an existing domain
Aaditional Options (O Add a new domain to an existing forest

Paths @) Add a new forest

Specify the domain information for this operation

snippy.coml

Root domain name:

spé

38. Set the Forest Functional Level to Server 2008
R27? Why? Because you are going to possibly
have some Server 2008 R2 servers in your

Select functional level of the new forest and root domain

netwqu. If you do not you can raise the Forest Forest functional level: Windows Server 2008 R2 —
Functional later. .
39. Give it a password as shown. Domain functional level: Windows Server 2003
40. Click next. Windows Server 2008
Specify domain controller capabilities | Windows Server 2008 R2.
Domain Name System (DNS) server Windows Server 2012
V] Global Catalog (GC
Type the Directory Services Restore Mode (DSRM) password
Password: * P@ssword
Confirm password: g
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41. You may get a delegation for this DNS server
cannot be created....don’t worry about that for
now. Just click next.

DNS Options

| i, A delegation for this DNS server cannot be created because the auth

Deployment Configuration . . .
Specify DNS delegation options
Domain Controller Cptions

DNS Options S

Additional Cptions

42. The NetBIOS name will be entered. You don’t
need to change that. NetBIOS names are only
used if you have Windows ME or 9x on your
network, which you don’t.

Additional Options

Deployment Configuration . : ! P
Verify the NetBIOS name assigned to the domain and change it if necessary
Domain Controller Options

The NetBIOS domain name: SNIPRY

DNS Opitions
Paths
Review Options

Prereguisites Check

spi

43. Click next on the additional options page.

44. Select OK or Next when it asks you where to put
SYSVOL, etc.

45. Sometimes you’ll put your Database Folder, Log
files folder, and SYSVOL folder on a different
disk...in fact it’s a really good idea to do that.
However we’ll leave it for now.

46. SYSVOL folder will store your scripts, group
policies, etc. that are loaded to computers as they
log into your domain.

Specify the location of the AD DS database, log files, and SYSVOL

Database folder: C:A\Windows\NTDS ‘:I
Log files folder: C:\Windows\NTDS =
SYSVOL folder: C:\Windows\SYSVOL (=]
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47. Now it will do a Pre-requisites check. This is Rerun prerequisites check
actually very cool because Server 2008 Active
Directory didn’t do this and sometimes you would

think it’s all working and find out it isn’t and then A View results
you can’t flgure out why! Hopgfully what you will "Allow cryptography algorithms compatible with Windows N| 4.0 that prevents weaker | |
see looks “ke. the one to the right. cryptography algorithms when establishing security channel sessions.
a. The first one tells me about cryptography .
on Windows 2012. That’s because | : : ; : :
chose a Server 2008 R2 Forest For more mformatlon_ab?ufc this settn:g, see Knowledge Base article 942564 (http://
Iowe_r level some of the new features will 1. A delegation for this DNS server cannot be created because the authoritative parent -
be disabled because the older NOS can't zone cannot be found or it does not run Windows DNS server. If you are integrating
do the same stuff. . . with an existing DNS infrastructure, you should manually create a delegation to this
b. The second one tells me it can’t find : : Z 3
p » DNS server in the parent zone to ensure reliable name resolution from outside the
another DNS server to be a “parent R ; . R 3
server for it. That's okay, we'll let this one domain “snippy.com”, Otherwise, no action is required. L
be the parent server. é» Prerequisites Check Completed v
c. Then it should say “Prerequisites Check
Completed. 1. If you click Install, the server automatically reboots at the end of the promotion operation.
d. Click install!

48. Let it install!

49. Answer the questions below. More abeut prerequisites

50. When your server FINALLY restarts (it is normal
for it to take a LONG time) you will be shown the
regular login screen. You now have a domain
controller for a DIFFERENT forest so you can’t log
into the domain until you set up a trust. We will do
that later.

51. Click on the arrow on the left for a different user.

52. Select “Other User” and type

a. Administrator
b. P@ssword
53. Let it logon in!

Tory Klementsen
SLAPHAPPY\teechur

Fa ssword

Questions

Go online and look up the following information:
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1. Whatis “Active Directory”?

2. What is the Forest Functional Level and why did you
choose it? (Hint—the answer isn’'t “Because you told
me t0.”)

3. What does it mean when the pre-requisite check tells
you that it can’t find a delegation for the DNS server?

4. What kind of “objects” can you add to Active Directory?

5. What is a Domain?

6. What is a Forest?

7. Can you have a forest within a domain?

8. Can you have multiple domains within a forest?

9. What's a user?

10. What is a group?

11. What is an organizational unit?

12. What is a computer in the context of Active Directory?

13. How do you make a computer a part of a domain?
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14. What is a Domain Server in the context of Active
Directory?

15. Once AD is fully installed, (oh yay...mine is restarting)
you will see three or four new programs under
Administrative Programs. List them:

Lab 3-6 Joining Your Workstation to the Domain

Before you start:
Make sure your servers are turned on. If you don’t have enough RAM, at least have one of them on, preferably ADDCA1.

© Tory Klementsen -50 - 3/18/2013
Z:\0-Skills Center\Modules\Networking\Mod 03 Topologies and Architectures\2013\Network+ Mod 03 Topologies and Architectures.docx




Directions

1. Turn on your Windows 7 Virtual Machine and log in. . :
. . . (") Obtain an IP address automatically
2. We are going to make this computer a member of your new domain! 7 .
3. Then we’re going to play with some packets. © @ Use the following IP address:
4. First make sure your Windows 7 has an IP address and can get on the 1P address: 192 . 168 . 1
Interwebs.
5. Don’tuse MY IP address, but use the one from lab 2-7 last unit that | told Subnet mask: 255.255.255. 0
you to use. Be sure your preferred and alternate DNS servers are YOUR
servers, not m|ne Default gateway: 192 . 168 . 1 1
6. Activate it if you haven’t done so already.
7. Right click on Computer and select properties. Obtain DNS server address automatically
@) Use the following DNS server addresses:
Preferred DNS server: 192 . 168 . 1
Alternate DNS server: 192 .168 . 1
[~ | validate settings upon exit | P
[ OK ] [ Cancel ]
8. Click the Change Settings button.
9. Click Network ID. Computer name, domain, and workgroup settings
10. This computer is part of a business network. Computer name: Win7PC @ Change settings
11. Your company uses a network with a domain. Full computer name: Win7PC
12. Username: Administrator Computer description:
13. Password: P@ssword (that’s what it SHOULD be, at least). Workgroup: WORKGROUP
14. Where it says Domain name, you need to change the name of the computer
to whatever your domain is. Mine is slaphappy.com so I'd type that in there.
15. It's g,omg to say it can’t flnq an account in the do,maln for your COMPUTER. Compliter name WINTPC
That’s because you haven’t created one, so that’s cool.
16. Leave Computer Name the same and type the domain in again.
P P g Computer domain: SLAPHAPPY.COM
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17.

18.

19.

20.

21.

22.
23.

24,

For some reason it’'s going to ask for your credentials...AGAIN! Type them

in again.

It'll do its thing and add you to the domain. Here’s what it is doing:

a. Checking the domain to see if the username you used is correct and
authenticating you.

b. Checking to see if that username has the right to join the domain and
create computer accounts.

c. Creating a computer account in the domain.

When it's done it will ask you if you want to create a domain user account

on this computer. YES you do.

Why? Because if you set a domain account on your computer as a local

administrator, when the computer won't talk to the domain you can log in

with that domain account locally and fix it.

Leave it the same (since you're only adding an already created account, not

making a new one). Click next.

Make it an administrative account.

When you're done it will tell you that you have to restart your computer. Do

that.

Note: You can do the same thing with a server, but not a domain controller.

You might have, for example, a web server or file server that you don’t use

for authenticating and controlling users.

Do you want to enable a domain user

The domain user will have access to all files, folde
files, folders, and programs on the network.

@ Add the following domain user account:

User name: administrator]

User domain: SLAPHAPPY.COM

25.
26.
27.
28.

29.

30.

Now check to find that computer domain. Go back to your server.

Go to Administrative Tools—>Active Directory Users and Computers.
Expand your server.

See those folders? Those are called Organizational Units. They are for
organizing users, groups, and computers. Click Computers and you should
see the computer you just joined to the domain.

Now go to your OTHER server. Do you see the same account there?

Wow! That’s nifty! Why does it do that?

ALUVE DNTUOOT y OUSCT S anid Cumpac | Naime | TYPE

[ Saved Queries 1A WINZPC Computer

53 slaphappy.com ‘

| Builtin -
BCoro.ic S

M =9 Namain Canéallaca

31.

32.

Go back to Windows 7. You'll notice that now you have to log in as
administrator. Don’t log in yet. It’s not Best Practice to log in as an
administrator on a local machine.

Let's do ONE more thing. We’'ll do more users later, but for now lets create
you as a user.

linistrator

o
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58. Go to ADDC1 e i R
59. Click on the Users Organizational Unit (OU). @ Delegate Control... k Bl E ‘ ﬂ 5
60. Notice that there are little one heads and little two heads. — Find... :
61. The one heads are users. There should be only two. Al mout | Name L
62. The two heads are groups. There are a bunch. W d Computer !
63. We're going to create a new users. F  AllTasks »  Contact !
64. Go under the Action Menu->New->User C: Tefeh Group '
65. Type in your full name. s : InetOrgPerson '
66. Create a logon name. Click next. gl ettt msImaging-PSPs !
67. Create a password. Note that your password MUST have at least three of the £ Properties MSMQ Queue Alias |
following: & Pri
. rinter '
a. Capital letter Help U
b. Small letter el :
c. Number \Shared Folder '
d. Symbol [ Groups 42, Domain Guests !
68. It must also be no less than 7 characters long. Domain Users !
69. Tell it that the user doesn’t have to change password at next logon. Y2 Enterprise A... !
70. And set it so password never expires. %2 EnterpriseR... !
71. Now to go ADDC2 and open Acti've Dire_ctory Users. and Computgrs. Wwow! %2 Group Policy ... !
That was fast, huh? It replicates immediately! (Replicates means it completely Guest |
copies the full Active Directory Database from one domain controller to the B e
other, so if one goes down the other one can take over.)
72. Now go to Win7 and logon as your new account. Were you able to get in? Note:
Because this is a regular user, you can’t log into your domain controller.
Think about it...do you want Joe User being able to walk up to a server
and log in? | don’t think so.
Questions
1. What is the address of your preferred DNS server?
2. What is the address of your secondary DNS server?
3. What is your subnet mask?
4. What is your Default Gateway?
5. What is a default gateway?
6. What is your domain name?
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7. How do you join a workstation to a domain?

8. Can you do that to a server too?

Lab 3-7 Using Network Monitor

On this lab you’re going to use a Windows 2008 Server computer (or Windows 2003) to take a peek at some data packets. Windows comes with some built in and
extra programs that you can use to monitor different types of network performance.

Get the following:
“® A computer running Windows 2008 Server with Active Directory installed
“B A workstation connected to server's domain
“B A crossover cable or hub and cables to connect the two computers together
YD Windows Server 2008 disk

1. Open up your ADDC1 and log in as administrator. 813 Microsoft Network Monitor 3.3 Setup - 33.1641.0 =[c

2. Download Microsoft Network Monitor (search for Netmon Server 2008 and go to the MS | ) ) @
download site). Installing Microsoft Network Monitor 3.3 /_/

3. Download the 64 bit version (not the ia version, which is for Itanium CPUS).

4. If it says your security settings don’t allow the download, change the security settings. ) e aeogt e o ot Wi T ot Mo e ek M 5 Ty

5. Tools—>Internet Options—> Security Tab-> Internet Button->Custom Level take several minutes.

S. I(?](S)tgil ttrr]](z iggw;);ds section and enable downloading. ] e e e

8. Use Windows Update (when it asks). ! |

9. It will install Network Monitor (aka NETMON) and the NETMON Parsers. t

10. Open netmon. e

11. Netmon is for capturing and looking at packets on a network. You can use it to identify Frame Number | Time Offset | Process Name [ Conv Id [ Source [ Destination [ Protocol Name | Descripti
problems on your network. For example, let's say your network bandwidth is suddenly 2 0.000000 Nebwarkinfocx Networdr
being eaten up. You know something is going on, but you don’t know what. : Sy Fomthy Net.. 010000000, SR 2 SNABIE

12. You can use Netmon to capture the packets and find out where they are coming from. 2 el Sl s it
What you might find is a Broadcast Storm. This happens when a malfunctioning NIC sends 2 S UohLaaB2i01s  Daksls I Hoite s
a bunch of “noise” out onto a network, slowing everything down. o 0. 256873 i1 BaiBLs  Drieis T Teh.rlooe

13. You get a LOT of information using Netmon, so don’t be overwhelmed. Let'’s just start a u 9312900 s T o o
capture. 15 31550 B oriarta e imais s S

14. Click New Capture. : :

15. Go to that capture and click the Start button and let it run.
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16. Scroll down and you can see what your packets are doing. In mine, for example, | see that
one computer asked for IP address to MAC address resolution to talk to it.
17. |1 see some SMB (server message blocks) negotiating a connection (at the transport layer, |
might add).
18. Notice you're connecting to a “tree” (a tree is a bunch of domains in a forest).
- - A ST T PE ooy
19. Now go into your Windows 7. . _ . {IPv4:0} 192.168.1.8  SNAPPY ICMP ICMP:Echo Request Mess
20. Open your command prompt and type ping nameofserver —t. The —t switch tells it to keep {IPv4:0} SNAPPY 192,168.1.8 ICMP ICMP:Echo Reply Messag
running a ping command until you stop it. (Where it says name of server, put the name of {IPv4:0} 192.168.1.8 SNAPPY ICMP ICMP:Echo Request Mess
YOUR server. {IPv4:0} SNAPPY 192.168.1.8 ICMP ICMP:Echo Reply Messag
. NNI2AE FEEC n1anra nnnnn COANTracaRDNI | COANTraaRDNI |
21. Now go back to your server. Scroll down in Netmon.
22. You'll see something like the picture to the right.
23. You can see it's using IPv4 (Internet Protocol Version 4), that 192.168.1.8 is pinging the
computer named SNAPPY and the ICMP protocol is sending requests. Then it is getting
reguests.
24. Now click on any one of those frames and look at the Frame Details window. F Details 3
25. What is the frame number? stz -
' ’ Frame: Number = 89, Captured Frame Length =
@-Echernet: Etype = Internet IP (IPv4),Destin
- Ipv4: Src = 192.168.1.7, Dest = 192.168.1.5
26. What is the length of the frame? +-Udp: SrcPort = DN5(53), DstPort = 63761, Le
Dns: QueryId = 0xC5B3, QUERY (Standard quer
..QueryIdentifier: 50611 (0xC5B3)
27. What is the media type? -- Flags: Response, Cpcode - QUERY (Standar
- QuestionCount: 1 (0x1)
< I
28. What is some of the other information you see?
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29.
30.
31.
32.

33.

34.

35.

36.

Now start another capture. Go to your IE and open a website. Click a few links.
Go back to Netmon.

Click on Internet Explorer to filter only queries that come from IE.

What do you see?

Go to your IE and type in a URL that doesn’t exist (I used www.goleanicky.com). Make
sure you get an error (probably Could Not Connect to Server).

Now go back and look at the Frame Summary. Scroll over so you can see, under
description, the HTTP Payload that corresponds to the bad URL. (Payload is what is
delivered in request to www.goleanicky.com.)

Right above it should be a RESPONSE. Click that frame. Click on HTTP: Response in the
Frame Details window.

It'll say “StatusCode”™ somewhere. Why couldn't it find this URL?

{TCP:211, IPv...

{TCP:211, IPv...

169.204.171.8
169,204.171.8
169.204.171.8
SNAPPY

SNAPPY
SNAPPY

169.204.171.8
{TCP:211, IPv... 169.204.171.8 SNAPPY
{TCP:211, IPv... SNAPPY 169.204.171.8
{TCP:211, IPv... SNAPPY 169.204.171.8
{TCP:211, IPv... 169.204.171.8 SNAPPY
SNAPPY 169.204.171.8

ﬂ'i P:214. TPv...
4

#-Tcp: Flags=...AP...,
—--Http:

ails x
rame: Number = 6596, Captured Frame Length = 1283
Ethernet: Etype = Internet IP (IPv4),Destinationid
Ipv4: Src = 169.204.171.8, Dest = 192.168.1.5, Nex
SrcPort=HOSTS2 Name Server (81
HTTP Payload, URL: http://goleanicky.com/
text/html; charset=]

#-payload: HttpContentType =

Why use NetMon on your server?
Look at your traffic and answer the following questions:
a. Locate an ARP Request. What IP address is making the request?

b. Whatis it asking for?

c. What is the response (it should show the MAC address)?

d. ARP is Address Resolution Protocol where you can give the computer an IP address and it will resolve it to the MAC address of the device.

e. Go under Filter->Display Filter>Load Filter>DNS->Protocol Filter DNS. Apply that filter. What do you see?

f. Play around with a few other things. Don’t worry if you don’t completely understand it right now.

Network Drawing Activity
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http://www.goleanicky.com/
http://www.goleanicky.com/

A small company has hired you to assist them in selecting a network topology and communication media to use in the building of a new network. The company is

small, but growing. Currently in the company campus, there are four different work areas with 25 computers in each area. They need to be networked, and in
addition they need to have the ability to link to a larger network within the city limits.

Job One—On your first meeting with the Acme team they tell you they would like to have some examples of basic network designs. On this piece of paper, or
using your paint program, draw and label examples of three basic network topologies for Acme.

Job Two—Explain the advantages and disadvantages of each of the topologies you summarized for the Acme Team. Based on your knowledge to this point, what
topology would you recommend?
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Job Three—Acme has discussed your options and done some reading on their own. They have some questions about coaxial cable versus twisted pair cable.
Draw up a comparison chart for them using MS Word and then make a recommendation on which should be used according to your current knowledge.

Job Four—Acme has decided to go with a coaxial based Ethernet system. Go online and price out for Gary

1000 feet of thicknet coaxial cable
100 connectors
Terminators

Describe the cost for each and the types of connectors/terminators required. Since you want to do the best job you can, go for the gold plated high-quality
components.

Job Five—Since Gary wants Thicknet, he’s going to have to abide by what rule? Describe this rule to him and explain why it will mean extra cabling.

Job Six—I am going to give each team a scenario. | want each team to create from that scenario the following:

1. A proposal to the company that addresses the following:
a. Different types of topologies, including

i. BUS

ii. Token-Ring

iii. Star
v. Cascading star
v. Mesh
b. Different types of architectures

i. Ethernet
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ii. Token-Ring
iii. ARCNet (just a brief overview because no one creates a new ARCNnet network any more)
iv. FDDI
Access methods of each
Which topology is best for their needs
e. Drawing of the proposed network including:
i. Servers
ii. Cabling (label type)
iii. Connectors
iv. Workstations
v. Access method
f. Include
i. Graphics
ii. Cable types
iii. Connector types
iv. Special cables if needed
v. Access speeds
vi. Label how the information moves around the network.
vii. 5-4-3rule if it applies
viii. Network type (peer to peer vs client/server)

oo

Create a proposal for each scenario and be prepared to present the proposal to the class. Use either PowerPoint or a report and use VISIO for the drawings.
Address all issues for full credit. See rubric below for exactly what you will be graded on.
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Rubric

Requirement

Excellent (10)

Good (8)

Poor (5)

Not Observed (0)

Explanation of the option of different kinds of topologies, including bus, star, cascading
star, token ring, and mesh.

Explanation of the options of different types of architectures, including Ethernet, token-
ring, ARCNet, and FDDI)

Access methods used by each topology.

Suggestion of which topology would best fit their needs.

Drawing of the network, which includes:

All computers on network (servers and workstations)

Label cable types

Label connector types

Label access speeds

Label access method

Describe topology and architecture

Worth 100 points. Points awarded:
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